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1 — Introduction

This document presents HydroBID Flood model instructional material and tutorials to facilitate 
the application of several model components using QGIS. HydroBID Flood is a software system 
based on the RiverFlow2D model developed by Hydronia LLC.

RiverFlow2D is a combined hydrologic and hydrodynamic, mobile bed, and pollutant transport 
finite-volume model for rivers, estuaries,coastal areas, and floodplains. It  can simulate floods and 
inundation over complex terrain at high resolution and with remarkable stability, accuracy and 
speed. The use of adaptive triangular-cell meshes enables the flow f ield to  be  resolved around 
key features in difficult r iver environments.

Hydronia computational engines use an accurate, fast and stable finite-volume solution method 
that eliminates the boundary and hot start difficulties of some two-dimensional flexible mesh mod-
els. RiverFlow2D also includes capability to represent dam or levee breaches and can integrate 
hydraulic structures such as culverts, weirs, bridges, and gates. The hydrologic capabilities in-
clude spatially distributed rainfall, evaporation and infiltration. This current version can integrate 
the effect of spatially distributed wind stresses on the water surface.

OilFlow2D is a two-dimensional model that simulates spreading of oil and viscous fluids on the 
land surface. It can simulate oil depths and velocity over irregular surfaces considering fluid prop-
erties such as density, viscosity that can vary in time. The model can use 3 different rheological 
formulations for Newtonian and non-Newtonian fluids that can have Yield Stress. The OilFlow2D 
model also accounts for oil evaporation and that process affects density and viscosity and its 
subsequent impact on fluid flow.

The user interface of Hydronia models is based on QGIS, a powerful software for the analy-
sis of geographic information systems of free distribution. This software system integrated with 
GMSH mesh generation plugin provides interactive functions to generate and refine t he finite-
volume flexible mesh, and uses familiar GIS objects to construct a  high level representation of the 
model. QGIS also offers a complete set of visualization tools that include rendering, for the 
representation of the results generated by the model.
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2 — Creating your First HydroBID Flood
Project

This section provides a step-by-step guide to help you get started with a HydroBID Flood project
using the QGIS interface. This procedure will include instructions to enter the terrain elevation
data, create the mesh, prepare the layers with the input information, and run HydroBID Flood.
The boundary conditions include an inflow hydrograph and uniform outflow.

2.1 Starting a new project
Before starting the project with QGIS. It is recommended to create a folder that would contain
all the necessary data such as the boundary conditions files, the elevation data files, either in
ASCII or in raster format, etc. In this section we will use the data of the example included in the
Hoh QGIS folder under My Documents\RiverFLow2D QGIS\ExampleProjects. The folder contains
the files shown:

Figure 2.1 – Files with data required for the example.

The file HohRiverBedElevations.txt is formatted to comma separated data, where the first
two columns correspond to point X and Y coordinates and the third column is the point elevation
as shown in the following figure.
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Figure 2.2 – File containing terrain elevation points.

2.1.1 Starting QGIS
The first step is to start the QGIS software. After loading we will have a window similar to the one
shown below:

Figure 2.3 – QGIS interface indicating window areas.

2.1.2 Start a new HydroBID Flood project
1. In the HydroBID Flood toolbar, click on the New HydroBID Flood Project button
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to start a new HydroBID Flood project. A dialog window appears where you select the layers
that will be created, the Coordinate Reference System (CRS), and the directory path where
the layers will be saved. This example will use the basic layers: Domain Outline, Manning
N, and BoundaryConditions

2. Select None in the Layers dropdown menu.

3. Select the Projection button. Note that it is EPSG:4326 is set as default, but should be
changed!.

4. In the Filter textbox, type 102748 and select the Coordinate Reference System as shown:

Figure 2.4 – Coordinate Reference System Selector dialog window.

5. Click OK.

6. The Coordinate Reference System (CRS) EPSG code: 102748 should be selected, and the
dialog window will look like this:
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Figure 2.5 – Create New HydroBID Flood Project.

7. Click the ”...” button to provide a path to store the project files in the Project Directory textbox.
This will be the folder where the model will write all results and output files.

8. After clicking OK, the layer templates are created, and displayed on the Layers Panel :

Figure 2.6 – Layers created for the project.

5



Creating your First HydroBID Flood Project

HydroBID Flood will use the unit system as that defined in the projection you selected. If the
projection has coordinates in feet, units will be set to English. If the projection coordinates
are in meters, units will be set to Metric or SI.

9. On the QGIS Project menu, click Save, to save the project in the same directory that you
previously selected in the Create New Project dialog above.

2.1.3 Load elevation data
HydroBID Flood uses elevation data in raster format. For instance, to load an ASCII grid file, from
the Layer menu, click Add Layer, and then click Add Raster Layer... You may also click the Add
Raster Layer button:

In this case we will use the elevation data in a tab delimited file. First, the file is loaded to
create an event layer. This can be accomplished as follows:

1. From the Layer menu, click Add Layer, and then click Add Delimited Text Layer... Alterna-
tively, you may also click the Add Delimited Text Layer button:

the following dialog is presented:
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Figure 2.7 – Dialog to create a layer from delimited data text file.

2. Here you must indicate the location and name of the file with the data in this case: Click the
Browse button and go to
C:\"username"\Documents\RiverFLow2D QGIS\ExampleProjects\HohRiverBedElevations.txt.
Under File format select Custom delimiters and Tab.

3. Make sure that the first row has the names of the fields, and this is assigned to X field, field 1
and Y field, field 2, then click OK to load the points in the project window. The Coordinate
Reference System Selector dialog box appears again and we can click OK to continue, the
correct CRS 102748 should already be present.

4. As surely the points are not within the extension of the window, you will have to click with
the right mouse button on the label of the created layer and select the option Zoom to the
layer.

7



Creating your First HydroBID Flood Project

Figure 2.8 – How to zoom to layer extent.

5. The points should appear in the project window:

Figure 2.9 – Layer of points created from delimited data file.

6. The raster is created interpolating from the data in the point layer. For that we will use
the Interpolation command which is found on the Raster menu under Interpolation. This
command is a plugin that is installed by default in QGIS. If for any reason it does not appear,
on the Plugins menu, click Manage and Install Plugins..., type Interpolation on the search
field, and then then select the Interpolation Plugin checkbox to enable it.
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Figure 2.10 – Loading to the QGIS interpolation plugin.

When executing it, the following dialog window appears:

Figure 2.11 – Interpolation plugin window.

7. In this window select the layer to be interpolated to create the raster, in this example, it
is the point layer that we just created HohRiverBedElevations. Change it by selecting the
dropdown for Vector Layers. We select the field that has the attribute that was used as
the value to interpolate, in this case the z field. This is done by clicking the dropdown for
Interpolation Attribute, selecting Z, then clicking the Add button.

8. Once added, go to select the interpolation method. There are 2 options: triangular interpo-
lation (TIN), or Inverse Distance Weighting (IDW). In this case the TIN method is selected,
then the resolution of the raster is defined, which is fixed to cells of 10ft × 10ft, which
generates a raster of 315 columns x 514 rows.

9. Select the path to the folder where the raster layer is to be created. It is recommended to
point to the project folder directory chosen earlier in the tutorial.
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10. Click OK.

Once the process is completed, the raster resulting from the interpolation will be displayed on
the screen, by default it is rendered in gray gradient as shown in Figure 12.6.

Figure 2.12 – Digital elevation model in raster format created by interpolation.

Right-clicking on the label of the created layer and selecting Properties allows you to change the
rendering style for a more informative color palette.

Figure 2.13 – Window to change the raster layer render style.
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And now the raster layer is displayed with the new color palette selected:

Figure 2.14 – Digital elevation model with color render.

It is convenient to move the raster layer created to the end of the list of layers, thus it does not
interfere with the display of other layers.

2.1.4 Create the limits of the modeling area
The limits of the modeling area are defined using a polygon on the Domain Outline layer. To
create it do as follows:

1. Click the Domain Outline layer to activate it and then click Toggle Editing (pencil) in the
toolbar:

Figure 2.15 – Menu buttons for digitalization toolbar.

2. This activates the rest of the editing buttons. Now click the Add Feature tool which is the
bean looking polygon.
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Proceed to delineate the outline of the polygon by marking the vertices clicking with the left
mouse button:

Figure 2.16 – Modeling area delimitation on the Domain Outline layer.

Make sure that the polygon is contained within the limits of the raster layer since
HydroBID Flood will not extrapolate elevations to areas that are outside of the available
data on the raster layer.

3. To finalize and close the polygon, right-click anywhere on the map view area. A dialog win-
dow to input the cell size attribute of the newly created polygon. The value for the reference
size of the mesh cell is indicated. Enter a value of 100 ft.
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Figure 2.17 – CellSize defined for the Domain Outline layer.

If you want to make any correction in the outline of the created polygon, use the Node Tool:

You can move, add or remove nodes as necessary.

4. Save the polygon by clicking the Save button

and click on Toggle Editing button to deactivate the layer Edit mode.

The Domain Outline is now complete.
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Figure 2.18 – Domain Outline layer.

2.1.5 Generating the triangular-cell mesh
Now that the Domain Outline layer has been created, proceed to create the mesh using the GMSH
program. There are 2 plugins to access this program. For this example we will use the plugin for
non-expert users which does not require the user to define any parameter.

To run the plugin, on the the Plugins menu, click Generate TriMesh, or click on the icon:

The following figure shows the generated mesh. You will also see in the Layers panel two new
layers: Trimesh and Trimesh point :
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Figure 2.19 – Resulting mesh.

If you want to know the mesh generation statistics, and other messages produced by the
GMSH program while creating the mesh, you can see it in the Log messages panel. This window
is accessed from the View menu, clicking Panels.

Figure 2.20 – Message panel of the registry with GMSH messages.
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2.1.6 Setting the boundary conditions
To define the boundary conditions:

Inflow boundary conditions. Draw a polygon that includes the nodes or vertices at the upper
end of the mesh as indicated in the figure:

Figure 2.21 – Polygon that covers the nodes defining the Inflow boundary condition segment.

1. Select the BoundaryConditions layer in the Layers panel.

2. Click the Toggle Editing button to add the polygons that are going to indicate the nodes on
which the inflow and outflow conditions are established.

3. To finish the polygon, right-click on desired location. A window to enter the attributes of the
newly created polygon is displayed.

4. The window contains a list to select the name of ID of this BC (Boundary Cond. ID), if it is
INFLOW or OUTFLOW condition, and a list to indicate the boundary condition Type. In the
File Conditions border field, click the button next to it and a dialog window will open to select
the file with the values of the contour condition if this is the case.

Enter the data as shown in Figure 2.22 below:
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Figure 2.22 – Inflow Boundary Condition data.

5. Click the Save button:

Outflow boundary conditions. We will draw the polygon as done with the Inflow Boundary
Condition but in the lower section of the mesh at the end of the channel. Below, the polygon that
includes the nodes that indicate the outflow segment:

Figure 2.23 – Polygon that includes the Outflow boundary condition nodes.

1. Draw the polygon defining the Outflow Boundary condition at the end of the channel.
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2. Right click to close the polygon, and a dialog window will appear to define the feature at-
tributes. In this case, the condition type Uniform flow conditions is selected, so that a file is
not selected, but instead the value of the slope is entered in So field. Enter the values as
shown:

Figure 2.24 – Attributes for the polygon layer that defines the outflow boundary condition.

3. Save the changes made to the layer:

4. Deactivate editing mode by clicking on the Toggle Editing button

The figure below shows how the BoundaryConditions layer looks:
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Figure 2.25 – Polygons that define the inflow and outflow boundary conditions.

2.1.7 Assigning Manning’s n
To assign Manning’s n values, we will enter polygons with particular n’s. There can be as many
polygons as those required to reproduce the spatial variability of this parameter. In this example,
a single polygon will be drawn for the entire area.

1. Select the Manning N layer and click the Toggle Editing button:

2. Draw the polygon around the entire domain taking care that it covers all the cells.

You should have an image like the one shown below:
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Figure 2.26 – Editing the Manning N layer.

3. Close the last vertices on the polygon by right-clicking on the desired position. The following
dialog window is presented where you must input the Manning’s n value associated to the
polygon. For this case, enter 0.035:

Figure 2.27 – Dialog to input Manning N Feature Attributes.

4. Click the Save button
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and then click the Editing Tool button

to deactivate editing mode.

Before using the Export plugin, save the QGIS project. To accomplish this, from the Project menu,
click Save. Name the project file Hoh.qgs.

2.2 Exporting the files
Once the layers with the input information to the model have been created, the next step is to run
the second plugin, which creates the data files required by the RiverFlow2D model.

1. Run the Export HydroBID Flood plugin

2. A dialog window is presented. We must indicate the raster layer of the Digital Elevation
Model (DEM), as this layer is not created by the plugin and its name may be different.

3. Indicate the path and file name. The path should be the same as that previously selected
and the same of the .qgs. Also, it should not be in the sub-directory shape where the shape
files corresponding to each layer are located.

4. Click OK.

Figure 2.28 – Export HydroBID Flood dialog.

The plugin will begin to process the information, in the message bar at the top it will indicate
the approximate progress of the process.
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Figure 2.29 – HydroBID Flood project screen after exporting the files.

Once the process of creating the files with the input data is finished, the Hydronia Data Input Programprogram
is opened automatically and a dialog window is presented with the model project to run. In
this case: Hoh.DAT should already be set.

Then the window with the input parameters of HydroBID Flood is presented, as shown in
the image below:

Figure 2.30 – Hydronia Data Input Program window.

5. Click the Run RiverFlow2D button to run the model. An image similar to the one shown
below should appear:
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Figure 2.31 – The graph generated by HydroBID Flood.

Take some time to explore the information included in this window.
This concludes the Creating your First HydroBID Flood Project using QGIS tutorial.
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3 — Simulating Levees using Weirs

This tutorial illustrates how to incorporate a levee to an existing HydroBID Flood project using the
Weirs Component in the QGIS interface. The problem consists in modeling a lateral weir along
the right margin of a river, as can be seen in the following figure.

Figure 3.1 – The weir polyline representing the levee is shown in red.

The procedure to incorporate the weir in a HydroBID Flood simulation involves the following steps:

1. Open an existing HydroBID Flood project.

2. Add Weirs layer

3. Draw the weir polylines

4. Input the weir parameters or attributes

5. Export the files to the HydroBID Flood

6. Run the HydroBID Flood model
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7. Review output files.

The files required to follow this tutorial can be found in the following directory:

...MyDocuments\RiverFlow2D QGIS\ExampleProjects\WeirsTutorial

3.1 Open an existing project
1. Open QGIS.

2. On the Project menu click Open... and browse to select the existing project: WeirsTutorial.qgs.
This project contains the following layers: domain polygon, Digital Elevation Model (DEM)
of the river bed in raster format, aerial photography, polygon with the Manning coefficient
and the polygons with the boundary conditions where the flow entrance is in the upper left
corner and exit in the lower left corner. The boundary conditions are a hydrograph with a
peak discharge of 220,000 ft3/s, and outflow condition is set to uniform flow. When you
open the project you will have a project image loaded in QGIS as shown in Figure 3.2:

Figure 3.2 – Example of the tutorial loaded in QGIS.

3.2 Create a Weir layer and the weir polyline
The weir location can be drawn on the Weirs layer or it can be imported from an existing file. In
this tutorial, the polyline that indicates the location of the weir will be imported from a text file. The
structure of the file should be as follows:
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• The first line must indicate the number n of nodes that contains the polyline.

• The n successive lines will contain three columns with the X, Y coordinates.

• The elevation of the weir crest separated by space as shown in Figure 3.3.

Figure 3.3 – Text file with weir alignment data.

Adding the Weirs layer involves the following steps:

1. Create Weirs layer: for this click on the New Template Layer button in the HydroBID Flood
toolbar

2. Activate the checkbox Weirs, as shown in the Figure below:
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Figure 3.4 – Plugin to add a new template layer.

3. Edit the Weirs layer: In the layer panel, we select the Weirs layer and in the digitalization
toolbar we click on the of the Toggle Editing button

A pencil icon will appear in the Weirs layer indicating that the layer is in edit mode:

4. Draw the line representing the weir: Using the Add Feature tool from the digitalization bar

Draw a line anywhere in the map area (just mark two vertices or nodes. This line will then
be replaced by the coordinates of the file to be imported)

5. Right-click to finish the layout and a dialog will open to input the weir parameters.

6. Input the weir parameters: The window to input the weir attributes contains 2 tabs. In the
first one there are the fields of the general parameters, within which we have:
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• Weir Name (ID): Weir1

• Weir discharge coefficient: 3.2

• Weir crest elevation for all the weir: since a file will be imported this field will be left
empty.

• Size Element: 150

• Import Geometry File: Click the [...] button and point to the file LeveeRB Breakline.txt
which is found in the tutorials folder.

The weir parameters window should look like the image shown below:

Figure 3.5 – Window to input Weir parameters.

In the second tab ’Weir crest elevation for vertex’ we can see that the data contained in the
file LeveeRB Breakline.txt that has been loaded as shown in the following Figure:

Figure 3.6 – Window for weir geometry data.

7. Then click on the [OK] button
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8. Save the changes in the layer using the Save button of the digitalization toolbar

9. Disable the editing mode of the layer with the Toggle Editing button

and we will have on screen an image similar to the one shown below where you can see the
layout of the weir:

Figure 3.7 – Weir alignment loaded from the file.

3.3 Generate the mesh
The mesh is generated with the Generate TriMesh plugin

result should look similar to the image on Figure 3.8.
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Figure 3.8 – The mesh generated.

3.4 Exporting files to RiverFlow2D
Now that you have generated the mesh and you have the other layers ready with the necessary
data, you should export the files in the format required by RiverFlow2D.

1. Click the Export to HydroBID Flood button.

2. When running the plugin a window is displayed, here we must select the raster layer that
contains the Digital Elevation Model (DEM) and the name of the project to be exported.
Enter the name without any extension.

3. Before executing the plugin, activate the layer with the DEM (if it is disabled) and turn off the
MeshDensityLine layer since it does not have any element.

Once the plugin is executed, a window will be shown (Figure 3.9), as it should be for our
example.

30



Simulating Levees using Weirs

Figure 3.9 – Plugin window to export the files to RiverFlow2D.

4. After inputting the data, click on the OK button and the export process will begin. Once it is
finished, Hydronia Data Input Program will be loaded as shown in Figure 3.10

Figure 3.10 – Control data panel.

3.5 Running the model
Make sure that the Weirs Component appears selected in the Control Data panel.

1. In the list of components, select ’Weirs’ and the panel of the Weirs component will appear.
In this window the contents of the .WEIRS file content as prepared by HydroBID Flood will
be displayed (Figure 3.11).
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Figure 3.11 – Weirs component data panel.

2. Leave all other parameters at their default values.

3. Click on the Run RiverFlow2D button in the lower section of Hydronia Data Input Program.
A window will appear indicating that the model began to run. The window also informs the
simulation time, the volume conservation error, the total input and output discharge and
other parameters as the execution progresses (Figure 3.12).

Figure 3.12 – HydroBID Flood output graphics.
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3.6 Review the output files
HydroBID Flood creates an output file with the name of the project and extension .WEIRI for
metric units and .WEIRE for English units. The files report results for each weir and for each
output interval. Output includes the following information:

• EDGE: The segments into which the weir is divided and is given by the length of the cells in
contact with the weir,

• N1 and N2: The numbers that identify the cells that share the EDGE segment in the weir,

• WSE1 and WSE2: The elevations of the water surface in the cells indicated by N1 and N2,

• D1 and D2: The depths of the flow in the cells indicated by N1 and N2,

• Distance: The length of the EDGE segment,

• Q: The discharge that passes through the EDGE segment.

The .WEIRE file contains the following:
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Figure 3.13 – Extract of the output file of the Weir1.

This concludes the Simulating Levees using Weirs Tutorial.
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4 — Simulating bridges

This tutorial illustrates how to incorporate a bridge into an existing HydroBID Flood project using
the Bridge Component through the QGISinterface. The procedure involves the following steps:

1. Create the bridge geometry data.

2. Open an existing HydroBID Flood project.

3. Enter the bridge polyline.

4. Enter the bridge data.

5. Generate the mesh.

6. Export the files of RiverFlow2D.

7. Running the model.

The files required to follow this tutorial can be found in the following directory:

...MyDocuments\RiverFlow2D QGIS\ExampleProjects\BridgesTutorial

4.1 Create a bridge geometry file
Integrating bridges in HydroBID Floodrequires preparing the bridge cross section geometry data
prior to running the model. With the QGISinterface you have the option of creating a simplified
bridge geometry from the terrain profile obtained from the digital elevation model, and then you
can use the Bridges panel in the Hydronia Data Input Program to perform the adjustments nec-
essary to the geometry generated by QGIS. This option is useful when the bridge is located on a
natural section of the river, and the geometry of the bridge is simple (Figure 4.1a). However, other
cases may involve more complex bridge geometries (Figure 4.1b), that require a more detailed
preparation of the bridge geometry file.
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Figure 4.1 – Bridge geometries.

Figure 4.2 shows the front view of the bridge that you will to incorporate into the model for this
tutorial. The data is also in the file BRIDGEGEOMETRY.DAT contained in the directory of this tutorial.

Figure 4.2 – Front view of the bridge.

It represents the cross section of a bridge with only one central pier, although this is just for
the purpose of illustrating the Bridges component in this tutorial since the actual bridge in this
location has about 12 sets of piers. This geometry is represented in the HydroBID Flood model
using the bridge geometry file shown below, where the header row is presented only to describe
the parameters, and they should not be included in the actual data file:
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Figure 4.3 – Data of the bridge geometry.

You may use the Bridges panel in Hydronia Data Input Program to create to some extent, or
edit a bridge geometry file (see Figure 4.4). The program lets you enter data in tabular form and
view a graph of the bridge geometry. You may also manipulate the graphical lines, which will make
that the tabular data be modified.
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Figure 4.4 – Bridges panel.

An alternative way to create the bridge geometry file is to use a spreadsheet. In the folder
for this tutorial there is a MS-Excel sheet (BridgesGeometryPlot.xlsx) that allows editing and
plotting bridge geometry files.

4.2 Open an existing project
On the Project menu click Open... to load the existing project: BridgeTutorial.qgs. This project
contains the layers of the domain contour, the Digital Elevation Model DEM of the river bed in
raster format, the polygons with the Manning’s n for the different land coverages, an aerial image,
and the boundary conditions. Inflow is located in the upper right segment, and outflow in the lower
left. The boundary conditions are a hydrograph with a peak discharge of 220,000 ft3/s (cfs), and
outflow condition is set to uniform flow. When you open the project you will have an image of the
project loaded in QGISas shown in Figure 4.5.
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Figure 4.5 – Project screen loaded in QGIS.

4.3 Enter the bridge polyline in the Bridges layer
This step ensures that the mesh will conform to the bridge alignment, so that there will be nodes
generated along the bridge. In this case we will enter the bridge is a straight line approximately
1740 feet long as follows:

1. Create a new Bridges layer: for this, go to the HydroBID Flood toolbar of and click with the
mouse on the New Template Layer button

in the plugin window we activate the Bridges checkBox, as shown in the Figure below
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Figure 4.6 – HydroBID Flood dialog to add new layer.

2. Edit the Bridges layer: In the layers panel we select the Bridges layer then in the digitaliza-
tion toolbar we click with the mouse on the Toggle Editing button

A pencil icon will appear in the Bridges layer that tells us that the layer is in edit mode:

3. Draw the line representing the bridge: (if necessary, turn off the DEM layer so that it does
not interfere with the identification of the bridge site in the aerial photograph).

4. Using the Add Feature button of the digitalization toolbar

draw the line indicating the location of the bridge. In the case shown, to demarcate the line
that indicates the location of the bridge, it is only necessary to indicate two vertices (initial
and final), then click with the right button to finish the drawing and we will have an image
similar to the one shown in the following figure:
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Figure 4.7 – Bridge drawing.

5. Enter the bridge data: After the bridge layout is finished, the window to input the attributes
of the bridge created is immediately displayed, these are:

• Bridge Name (ID): Bridge1

• Size Element: 150 feet

• Bridge file: Bridge1.txt (In this case, we will let QGIS build the bridge file, so we only
indicate the name of the file)

• Elevation of the lower bridge deck (LOWCHORD): 138

• Elevation of the bridge deck (DECKELEV): 142

The figure below shows the attributes window of the Bridges layer:
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Figure 4.8 – Attribute dialog window of the Bridges layer.

6. After entering the values, click on the [OK] button, save the changes in the layer using the
save button of the digitalization toolbar

and disable the editing mode of the layer with the Toggle Editing

4.4 Generate the mesh
The mesh is generated with using the HydroBID Flood emphGenerate TriMesh icon

check that the resulting mesh is perfectly aligned with the bridge as shown in Figure 4.9.
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Figure 4.9 – Mesh aligned with bridge polyline.

4.5 Exporting files to HydroBID Flood
Now that you have generated the mesh, and you have ready the other layers with the necessary
data, you should export the files in the format required by HydroBID Flood.

1. Click on Export HydroBID Flood button:

In the export files dialog we need to make sure that the appropriate raster layer correspond-
ing to the Digital Elevation Model (DEM) is selected. Also enter the name of the project; only
the name must be indicated without any extension.

Once the complement is executed, a window is presented as shown in Figure 4.10, as it
should be for our example.
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Figure 4.10 – Export HydroBID Flood tool.

2. After input the information, click on the OK button and the export process will begin.

Once finished, the RiverFlow2D program will be loaded with the .DAT file of the specific
example.

4.6 Running the Model
After exporting the files, the HydroBID Flood program is loaded with the project file of the bridge.DAT

example, and the Control Data panel is shown (Figure 4.11).

Figure 4.11 – Control Data panel.

Select the Bridges panel to review the contents of the bridge geometry file (Figure 4.12). Note
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how the bridge profile was discretized every 150 feet according to the element size imposed to
the bridge line.

Figure 4.12 – Bridges component data panel.

Leave all other parameters at their default values.

To run the model, click on the Run HydroBID Flood button in the lower section of Hydronia Data Input Program.
A window will appear indicating that the model run started. The window also reports the simulation
time, the volume conservation error, the total input and output discharge, and other parameters
as the execution progresses (Figure 4.13).

Figure 4.13 – RiverFlow2D output graphics.
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You may take some time to review the BridgeTutorial.bridgeh file:

Figure 4.14 – Bridge hydrograph file .bridgeh.

This concludes the Simulating bridges tutorial.
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5 — Simulating culverts

This tutorial shows how to incorporate culverts in an existing HydroBID Flood project using the
QGIS interface. The problem consists of a natural channel crossed by a road embankment. A
culvert structure is to be used to connect the upstream and downstream parts of the channel
divided by the embankment as shown in the following figure:

Figure 5.1 – Culvert scheme.

The water enters from upstream with a constant discharge of 1000 cfs, and outflows down-
stream along the indicated section. The area is initially dry. The culvert has a circular cross
section, and other characteristics as summarized in the following Table (CulvertA). CulvertB data
is provided in case that you wanted to extend the tutorial adding a second culvert to the project.
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Parameter Description Culvert A Culvert B

Nb Number of identical barrels 1 1
Ke Entrance Loss Coefficients 0.5 0.7
n Mannings n Coefficient 0.014 0.015
Kp Inlet Control Coefficient 0.3 0.4
M Inlet Control Coefficient 2 2
Cp Inlet Control Coefficient 1.28 1.1
Y Inlet Control Coefficient 0.67 0.69
m Inlet Control Coefficient -0.5 -0.5
Dc Diameter (feet) 3 2
- Inlet Inverted elevation -9999 -9999
- Outlet Inverted elevation -9999 -9999

The procedure to integrate this culvert into a HydroBID Flood simulation involves the following
steps:

1. Open an existing HydroBID Flood project.

2. Add a Culvert component layer.

3. Draw the line of culvert alignment.

4. Input the data or attributes for the culvert.

5. Export the files to the HydroBID Flood program.

6. Running the model.

7. Review culvert output files.

The files required to follow this tutorial can be found in the following directory:

...MyDocuments\RiverFlow2D QGIS\ExampleProjects\CulvertTutorial

5.1 Open an existing project
1. Open QGIS.

2. On the Project menu click Open... and browse to the existing project: CulvertTutorial.qgs.

This project contains the following layers: domain outline, Digital Elevation Model (DEM) in
raster format, polygon with the Manning’s n coefficient, and the boundary condition polygons.
The inflow is located in the upper left, and the outflow in the lower left. The boundary conditions
corresponds to a constant discharge of 1000 ft3/s, and outflow conditions is set to free. Figure
5.2 shows the opened project.
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Figure 5.2 – Example of the tutorial loaded in QGIS.

5.2 Create Culverts layer and draw the Culvert
1. To create the Culverts layer, in the HydroBID Flood toolbar click on the New Template Layer

icon

2. In the window select the Culverts checkBox, as shown:
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Figure 5.3 – Plugin to add a New Template Layer.

3. Edit the Culverts layer: In the layers panel, select the Culverts layer and in the digitalization
toolbar we click on the Toggle Editing button

A pencil icon will appear in the Culverts layer indicating that the layer is in edit mode:

4. Draw the line representing the culvert alignment: Using the tool Add Feature from the digi-
talization toolbar

draw the line that represents the culvert. It is only necessary to indicate two vertices.

5. Click with the right button to finish, and you should get an image similar to the one shown in
the following Figure:
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Figure 5.4 – Culvert alignment.

6. Enter the culvert data: After the culvert drawing is finished, the window to input the culvert
attributes immediately appears. The dialog window has 2 tabs, in the General tab you enter
the basic data for circular and box culverts:

• Culvert Name (ID): Culv1,

• Type of culvert: Type 2 (Circular culvert)

• Culvert File: Culv1.txt

• The rest of the parameters are coefficients that needed to compute the culvert dis-
charge. To help with the introduction of these parameters, the window presents a list
with default values for different types of culverts. If one of the values of the list param-
eters is not appropriate, you can choose the option where the value is defined by the
user (user defined). The window of the culvert parameters should be similar to the one
shown in the Figure below:
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Figure 5.5 – Window to input Culvert parameters.

7. After inputting the values, click on the OK button.

8. Save the changes in the layer using the Save button of the digitalization toolbar

9. Disable the editing mode of the layer with the Toggle Editing button

5.3 Generate the mesh
The mesh is generated with the Generate Trimesh tool

the results obtained as shown in Figure 5.6.
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Figure 5.6 – Final mesh.

5.4 Exporting files to HydroBID Flood
Now that you have generated the mesh and you have the other layers ready with the necessary
data, you should export the files in the format required by HydroBID Flood.

1. Click the Export HydroBID Flood button

2. Select the raster layer that contains the Digital Elevation Model (DEM) and the name of the
project to be exported. Indicate a name without any extension, in this case, CulvTutorial.

3. Before running the plugin, activate the layer with the DEM (if it is disabled) and deactivate
the MeshDensityLine layer, since it does not have any element.

Once the plugin is executed, a window will be shown (Figure 5.7), as it should be for our
example.
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Figure 5.7 – Plugin window to export the files.

After input the information, click on the OK button and the export process will begin, once
finished, the HydroBID Flood program will be loaded with the CulvTutorial.DAT file.

5.5 Running the model
After exporting the files, the HydroBID Flood program is loaded with the project file from the
culverts.DAT example and shows the Control Data panel to it as illustrated in Figure 5.8.

Figure 5.8 – Control data panel.

Note that the Culverts Component appears selected. On the left side of the Control Data
panel, in the list of components select Culverts to activate the Culverts panel. The contents of the
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culvert file prepared by QGIS will be displayed (Figure 4.10).

Figure 5.9 – Culverts component data panel.

Leave all other parameters at their default values.
To run the model, click on the Run RiverFlow2D button in the lower section of Hydronia Data Input Program.

A window will appear indicating that the model began to run. The window also reports the simu-
lation time, volume conservation error, total input and output discharge, and other parameters as
the execution progresses (Figure 5.10).
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Figure 5.10 – Runtime graphics.

5.6 Review culvert output file
For each culvert, HydroBID Flood creates an output file called: CULVERT culvertID.out, where
culvertID is the name (ID) entered when we created the culverts. Output includes the series of
discharge versus time through the culvert and the elevations of the water surface at the inflow and
outflow locations. For this tutorial, you will find a file called CULVERT Culv1.out, whose content is
shown in the following figure:
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Figure 5.11 – Culvert1 output file.

This concludes the Simulating culverts tutorial.
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6 — Simulating dam breaches

This tutorial illustrates how to incorporate dam breach simulation into an existing HydroBID Flood
project using the QGIS interface. The exercise consists of modeling the a dam break flood. The
dam is approximately 1575 feet long, the breach center is 550 feet from the right margin of the
dam, the opening of the breach has the final dimensions shown in the following Figure, a top width
of 160 feet, and at the bottom width of 100 feet, the final breach height is 30 feet.

Figure 6.1 – Final dimensions of the dam breach.

For this exercise, a file with the time evolution of the breaching dimensions is required, this
file can be prepared before setting the model or it can be created when entering the input the
parameters. The procedure to model the dam break involves the following steps:

1. Open an existing HydroBID Flood project.

2. Create a DamBreach layer and to draw a line that represent the transverse axis of the dam.

3. Generate the mesh.

4. Run the model.

The files required to follow this tutorial can be found in the following directory:

...MyDocuments\RiverFlow2D QGIS\ExampleProjects\DamBreachTutorial
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6.1 Open an existing project
1. Open QGIS

2. On the Project menu click Open... and browse to the existing project: DamBreach.qgs.

This project contains the Domain Outline layer, the digital elevation model DEM of in raster
format, outflow conditions are set to free outflow in the lower left, and an initial condition of water
surface elevation behind the dam. Figure 6.2 shows the project in QGIS.

Figure 6.2 – Project loaded in QGIS.

6.2 Create the DamBreach layer and draw the line that

defines the dam
Creating the dam involves the following steps:

1. Create the template for the DamBreach layer: in the HydroBID Flood toolbar click on the
New Template Layer button

2. In the dialog select DamBreach, as shown in the figure below:
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Figure 6.3 – Dialog to add a new layers.

3. Edit the DamBreach layer: In the layers panel, select the DamBreach layer.

4. In the digitalization toolbar we click on the Toggle Editting button

A pencil icon will appear in the DamBreach layer, indicating that the layer is in edit mode:

5. Draw the line that defines the axis of the dam: Using the Add Feature tool of the digitalization
toolbar

6. Draw the line that defines the dam axis. Keep in mind that the breach centroid is measured
from the first vertex of the dam line. In this example it occurs 550 feet from the left margin
of the dam (Figure 6.1). The dam axis is drawn from the top of the channel (point v0) to
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the bottom (point v1) along one side of the polygon that defines the initial water surface
elevation, as illustrated in the image below.

Figure 6.4 – Dam axis.

7. Input of the dam breach parameters: Once finished drawing the dam axis, the window to
input the parameters of the DamBreach appears.

8. The tool will create the file with the breach temporal evolution data on the table. The other
parameters of the breach are shown in the figure below:

Figure 6.5 – Dialog to input the dam breach parameters.

9. The temporal evolution of the Breach1.TXT file is shown Temporal evolution tab as shown
below:
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Figure 6.6 – Evolution of the breach of the dam.

Figure 6.7 – Dam axis.

6.3 Generate the mesh
The mesh is generated using the Generate TriMesh tool

Figure 6.8 shows the resulting mesh of almost 11,000 cells
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Figure 6.8 – The resulting dam breach mesh. Detail show mesh along the dam axis.

6.4 Exporting files to HydroBID Flood
1. Click on the Export HydroBID Flood button.

2. Select the raster layer that contains the Digital Elevation Model (DEM) and the name of the
project.

3. Input the name without any extension. For this example it will be: DamBreach.
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Figure 6.9 – Export dialog.

4. Once finished inputting the information, click on the OK button and the export process will
begin. Once it is finished,HydroBID Flood will be loaded with the DamBreach.DAT file.

6.5 Running the model
After exporting the files, Hydronia Data Input Programis loaded with the project file of the DamBreach.DAT

example and shows the Control Data panel as illustrated in Figure 6.10.

Figure 6.10 – Hydronia Data Input Program.

It can be seen that the Dam Breach component is selected as well as the initial condition that
indicates that the initial elevation of the water surface of the .FED file will be read. Selecting from
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the list on the left panel the Dam Breach component will show the panel where you can see the
parameters of the dam breach as shown in the figure below:

Figure 6.11 – Dam Breach component.

1. Before running the model, set the simulation time to 4 hours.

2. Leave all other parameters at their default values.

3. To run the model, click on the Run RiverFlow2D button in the lower section of Hydronia Data Input Program.

4. Save the changes with the same name as the DamBreach.DAT file.

A window will appear indicating that the model has started running. The window thatHydroBID Flood
presents while running the model shows simulation time information, volume conservation error,
the total input and output discharge as well as other parameters as execution progresses (Figure
6.12).
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Figure 6.12 – HydroBID Flood output graphics.

6.6 Review the output files
HydroBID Flood output the dam breach hydrograph in a file with extension .dambreachh. Figure
6.13 shows a section of that file for this exercise.
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Figure 6.13 – Extract of the DamBreach.dambreachh file

This concludes the Simulating dam breaches tutorial.
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7 — Using Manning’s n ESRI shape
files

This tutorial illustrates how to use Manning’s n files in ESRI shape file format to assign Manning’s
n values to an existing project using the QGIS interface. The procedure includes the following
steps:

1. Open an existing HydroBID Flood project.

2. Load the shape files with the Manning’s n polygons.

3. Import the Manning’s n geometry and values to the Manning N layer

The files required to follow this tutorial can be found in the following directory:

...\Documents\RiverFlow2D QGIS\ExampleProjects\ManningsNShapefileTutorial

7.1 Open an existing project
1. Open QGIS

2. On the Project menu click Open... and browse to the existing project: ManningsN shapefile.qgs.

This project contains the layers of the domain contour, the Digital Elevation Model (DEM) of
the river bed in raster format, an aerial photograph, and the boundary conditions layer where
the inflow is located in the upper right and outflow in the lower left. The inflow boundary
condition is a hydrograph with a peak discharge of 220,000 ft3/s, and the outflow conditions
is set to Free outflow. When you open the project you will have an image of the project
loaded in QGIS as shown in 7.1.
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Figure 7.1 – Project loaded in QGIS.

7.2 Load the shape file with the Manning’s n polygons

1. In order to load the shape file with the polygons containing the Manning’s n values, click on
Add Vector Layer button

of Manager layer toolbar or from the main menu Layer → Add layer → Add Vector Layer...

2. In tutorial folder, point to the SaltRiver ManningsN.shp file (Figure 7.2).

Figure 7.2 – Window to find and open the shape file.
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When loading the file, an image similar to the one shown in the following figure will be
displayed on the screen:

Figure 7.3 – SaltRiver ManningsN Layer.

7.3 Import the Mannings n geometry and values to the

Manning N layer
To transfer spatial and attributive information from the shape file to the Manning N layer, a copy
and paste operation is performed, but it must be ensured that both layers have a field or column
with the same name. The procedure is as follows:

1. Check the fields name of shape file: Right-click on the layer label and in the pop-up menu
select the option Open attribute table (Figure 7.4).
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Figure 7.4 – Attribute table of the SaltRiver ManningsN layer.

You can see that the shape file loaded has two fields, LUCode and N Value, the first one with
the coding of the land cover type and the second corresponds to the value of the Manning’s
n, in the case of the Manning N layer, it has a single field called ManningN.

2. Change the name of the field in the shape file: proceed to change the name of the field
N Value to ManningN, for this close the table of attributes and right-click on the layer label.
In the pop-up menu, select Properties then in window that opens select the Fields tab as
shown in Figure 7.5:
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Figure 7.5 – Properties the SaltRiver ManningsN layer.

3. Click on the Toggle Editing button

then change the N Value field name by ManningN (Figure 7.6), and click on the Toggle
Editing button again, and save.

Figure 7.6 – Field properties of the edited SaltRiver ManningsN layer.

4. Copy the polygons of the shape file: select the SaltRiver ManningsN layer in the Layers
Panel.

5. With the select tool

we draw a rectangle that covers the entire layer.

6. Copy the spatial elements by clicking on the Copy button of the digitization toolbar
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7. Paste the spatial elements in the Manning N layer: select Manning N layer of the Layers
Panel and set it in edit mode by clicking on the Toggle Editing button

8. Click on the Paste Feature button

and a message will appear that indicates that features were successfully pasted.

9. Click on the Toggle Editing button again

changes made to the layer are accepted and saved.

To check, open the table of attributes of the Manning N layer and you can see that the polygons
have been copied with their Manning n values. As shown in the Figure below:
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Figure 7.7 – Attribute table of the Manning N layer.

You can now remove the SaltRiver ManningsN layer from the Layer Panel.
This concludes the Using Manning’s n ESRI shape files tutorial.
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8 — Simulating bed load sediment trans-
port with limited erosion bed ar-
eas

In the Sediment Transport model you can define areas with a maximum erosion depth. This is
useful to represent pavements, rock outcrops or any surface that does not erode or that it has
a known erodible layer of sediment above it. This tutorial illustrates how to perform a sediment
transport simulation in which there is a non-erodible area using the QGIS interface. The procedure
includes the following steps:

1. Open an existing HydroBID Flood project.

2. Create a MaximumErosionDepth layer and the polygons that define the limited erosion areas.

3. Generate the mesh.

4. Running the model.

The files required to follow this tutorial can be found in the following directory:

...\Documents\RiverFlow2D QGIS\ExampleProjects\MaxErosionDepth

8.1 Open an existing project
1. Open QGIS

2. In the main menu go to Project →Open... browse to the existing project: MaxErosionDepth.qgs.

This project contains the layers of the domain contour, of the digital elevation model DEM of
the river bed in raster format, the layer with the boundary conditions where inflow is located in
the upper left and outflow in the lower left. The boundary conditions are a hydrograph with a pick
discharge of 6,500 ft3/s and outflow condition is set to free outflow. When you open the project
you will have a project image loaded in QGIS as shown in Figure 8.1.
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Figure 8.1 – Project screen loaded in QGIS.

8.2 Add template of the MaximumErosionDepth layer

and draw the polygon that define the area of limited

erosion
To add the template where the areas with limited erosion are drawn involves the following steps:

1. Create the template for the MaximumErosionDepth layer: In the HydroBID Flood toolbar
click on the New Template Layer button

2. Activate the checkbox MaximumErosionDepth, as shown in the Figure below:
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Figure 8.2 – Plugin to add a New Template Layer.

3. Edit the MaximumErosionDepth layer: In the layers panel, select the MaximumErosionDepth
layer and in the digitalization toolbar we click on the Switch tool button

A pencil icon will appear in the MaximumErosionDepth layer, indicating that the layer is in
edit mode:

4. Draw the polygon of the limited erosion area: Using the Add Feature tool

draw the polygon that defines the area of limited erosion. The polygon should cover all the
cells that will have limiting erosion. In this tutorial we will assume that an area on the river
has the maximum erosion depth limited to 0.1 feet, at the end you should have an image
similar to the one shown in the following figure:
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Figure 8.3 – Polygon of the area with limited erosion.

Once you finish drawing the polygon, the window to input the area parameters immediately
appears. Input a maximum depth of erosion of 0.1 feet, as shown below:

Figure 8.4 – Window for input the polygon parameters of MaximumErosionDepth layer.
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8.3 Generate the mesh

Generate the mesh using the Generate TriMesh button

The results obtained as shown in Figure 8.5 (mesh of close to 17,500 cells).

Figure 8.5 – The mesh generated.
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8.4 Exporting files to HydroBID Flood
Now that you have generated the mesh and you have the other layers with the necessary data,
export the files in the format required by HydroBID Flood.

1. Click on the Export HydroBID Flood button

2. When run the plugin a window is displayed, select the raster layer that contains the Digital
Elevation Model (DEM) and the name of the project to be exported. Input the name without
any extension. For this example it will be: MaxErosion.

3. Before running the plugin activate the layer with the DEM (if it is deactivated).

Once the plugin is executed, a window will be shown (Figure 8.6), as it should be for our
example.

Figure 8.6 – Plugin window to export the files to HydroBID Flood.

4. Once finished inputting the information, click on the OK button and the export process will
begin.

Once it is finished, tHydroBID Flood will be loaded with the MaxErosion.DAT file of the specific
example.

8.5 Running the model
After exporting the files, HydroBID Flood is loaded with the project file of the MaxErosion.DAT

example and shows the Control Data panel to it as illustrated in Figure 8.7
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Figure 8.7 – Control data panel.

Note that the sediment transport module appears selected and displays a message warning
that the file with the sediment information must be created. The procedure includes the following
steps:

1. To create the .SEDB file with the parameters to calculate sediment transport: in the Modules
list select SedimentTransport.

2. Enter the parameters for transport in suspension and bed load transport, for this example
the transport of sediments in suspension is deactivated and bed load transport is left active.

3. Add the sediment fractions to be considered: for this example add a single fraction with the
default values presented by the Hydronia Data Input Program, we will have an image similar
to the one shown in the following Figure:

Figure 8.8 – HydroBID Flood Sediment Transport Module.

Leave all other parameters at their default values.
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4. To run the model, click on the Run RiverFlow2D button in the lower section of Hydronia Data Input Program.

5. Save the changes with the same name of the MaxErosion.DAT file, then a window will ap-
pear indicating that the model started running.

The window presented while running the model shows: information of the simulation time,
the volume conservation error, the total discharge of the liquid flow in and out and in this case
also shows the sediment load at the inlet and outlet as well as other parameters as the execution
progresses (Figure 8.9).

Figure 8.9 – HydroBID Flood output graphics.

8.6 Check the output files

HydroBID Flood creates the following files for output time interval defined in the Control Data
panel:

CELL TIME METRIC DDDD HH MM SS.TEXTOUT (Metric Units) or

CELL TIME ENG DDDD HH MM SS.TEXTOUT (English Units)
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where DDDD indicates the date, HH, hour, MM minutes and SS seconds.
Column 6 reports the changes in the elevation of the river bed with respect to the initial el-

evation. We can also visualize the changes in the elevation of the riverbed generating layers in
vectorial format map from the aforementioned files using the Maps of Results vs Time

In the following figure, the river elevation difference map for the end of the run. At the time
0000:02:00:00 it can be observed that the zone where the erosion was limited, does not present
erosion, but deposition:

Figure 8.10 – Maps of elevation difference of the river bed between the initial time and at the end of the
run.

This concludes the Simulating bed load sediment transport tutorial.
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9 — Hydrologic simulations

The conceptual model of a hydrologic simulation with RiverFlow2D requires a series of non-
overlapping polygons where the rainfall/evaporation and infiltration data will be assigned to the
mesh. Only areas covered by polygons will receive rainfall or consider infiltration depending on
the case. Each Rainfall/Evaporation polygon should be associated with a file containing a rainfall
and evaporation time-series file. Similarly, each Infiltration polygon should correspond with a file
containing the infiltration calculation method and its parameters for the polygon. The user will
need to generate the rainfall and infiltration data files associated with each polygon, and copy
them to the project folder prior to running the model.

This tutorial illustrates how to perform a hydrologic simulation accounting for rainfall, evapora-
tion and infiltration. The procedure includes the following steps:

1. Create the rainfall and evaporation time series data files.

2. Create the infiltration data files.

3. Open an existing RiverFlow2D project.

4. Add the template of the RainEvap component layer and the rain/evaporation polygons.

5. Add the template of the Infiltration component layer and the Infiltration polygons.

6. Generate the mesh.

7. Running the model.

8. Visualize model results.

Note: The files required to follow this tutorial can be found in the following directory:

...MyDocuments\RiverFlow2D QGIS\ExampleProjects\RainfallInfiltrationTutorial
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9.1 Create the rainfall and evaporation time series data

file
To run a hydrologic simulation with RiverFlow2D, polygons will be created on which the rainfall/
evaporation data will be applied, but you must first create the ASCII text files with the rainfall and
evaporation time series that will be associated with each polygon. These files can be created
with any text editor, such as Notepad or Wordpad. The rainfall/evaporation file has the following
format:
Line 1: NPRE Number of points in the time series of rainfall and evaporation

Then follows NPRE lines containing:
Time (hr) Precipitation intensity (mm/h or in/h) Evaporation (mm/h or in/h)

The following table is an excerpt of the Rainfall1.dat file that is included in the folder for this
tutorial. In this example, evaporation is assumed to be zero at all times. Figure 9.1 shows the
graphical representation of the rainfall time series in the Rainfall1.dat file.

18

0.0 0.0 0.0

0.08 1.8 0.0

0.17 3.5 0.0

0.25 7.8 0.0

0.33 12.0 0.0

0.42 15.0 0.0

...

1.17 9.0 0.0

1.25 4.7 0.0

1.33 3.0 0.0

1.42 2.4 0.0
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Hydrologic simulations

Figure 9.1 – Rain intensity time series.

9.2 Create the infiltration parameters data file

To take into account infiltration, polygons will be created in which you specify the infiltration calcu-
lation method, and its corresponding data. The infiltration polygons are completely independent
from the precipitation polygons. Each polygon can use a different method with its associated
parameters. You will need to create the infiltration ASCII text files for each polygon. These files
can be created with any text editor, such as Notepad or Wordpad. The infiltration file is described
in detail in the RiverFlow2D Reference Manual. For this tutorial, given that the watershed has an
area with natural coverage in the upper area, and another with urban use in the lower area of
watershed, we will use two infiltration files using the the SCS-CN method to calculate the infiltra-
tion. File Infiltration1.dat will be used for the upper watershed, and for the lower urban zone,
Infiltration2.dat file. Both files are provided in the folder for this tutorial.

9.3 Open an existing project

1. Open QGIS

2. On the Project menu click Open... and browse to the existing project: RainfallInfiltrationTutorial.qgs.
This project contains the information to simulate the rainfall runoff resulting from a 10 yr
storm. The layers contained are the following:

• Domain Outline

• Digital Elevation Model (DEM) in raster format

• Aerial photography

• Polygons with the Manning’s n coefficients
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• Cross section at watershed outlet

• Outflow boundary conditions set to free outflow

When you open the project you will have an view similar as that shown in Figure 6-2.

Figure 9.2 – Rainfall and infiltration tutorial loaded in QGIS.

9.4 Add the RainEvap component layer, and the

rainfall/evaporation polygons
To add the RainEvap where the polygons are drawn with the rainfall and evaporation data, do the
following:

1. To create RainEvap layer use the New Template Layer button

2. In the window check RainEvap, as shown in the Figure below. Then click OK:
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Figure 9.3 – Dialog to add a new layer.

3. Edit the RainEvap layer: In the layers panel, select the RainEvap layer and click on the
Toggle Editing button in the digitization bar

A pencil icon will appear in the RainEvap layer, indicating that the layer is in edit mode:

4. Draw the polygon that demarcates the spatial distribution of rainfall and evaporation: Using
the Add Feature tool from the digitalization bar

draw the rainfall/evaporation polygon, as only one file will be used. The polygon should
covers the entire Domain Outline as shown in the figure below:
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Figure 9.4 – Polygon with the spatial distribution of Rainfall/evaporation data.

5. Input the parameters or attributes of the RainEvap polygon: just after the polygon is fin-
ished, the dialog to input the parameters will open, clicking on the button [...] search the
Rainfall.dat file in the folder of this tutorial.

9.5 Add the Infiltration component layer, and the

Infiltration polygons
To add the infiltration information, do as follows:

1. To create the Infiltration layer y use the New Template Layer button

2. In the dialog select Infiltration, as shown in the Figure below:
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Figure 9.5 – Plugin to add a new template layer.

3. Edit the Infiltration layer: In the layers panel, select the Infiltration layer and click on the
Toggle Editing tool

A pencil will appear in the Infiltration layer, indicating that the layer is in edit mode:

4. Draw the polygon that demarcates the spatial distribution of the infiltration: Using the tool
Add Feature tool of the digitalization bar, draw the infiltration polygons

Figure 9.6 shows the polygons that define the two infiltration zones of the watershed that
are based on the land use and vegetation cover.
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Figure 9.6 – Infiltration areas of the watershed.

5. Draw a polygon for the infiltration2 area trying to maintain the shape as indicated in the
previous figure and that protrudes from the polygon of the Domaine Outline as shown in the
figure below:

Figure 9.7 – Polygon of the infiltration2 area of the watershed.

6. Once completing the polygon, the dialog to input the parameters opens. Browse to the input
file Infiltration2.txt, as shown below:
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Figure 9.8 – Window to input the parameters for the infiltration2 polygon.

7. To draw the second polygon corresponding to infiltration2 use the snapping option as shown
in the section Advanced Digitalization/Snapping Tutorial and there should be a polygon like
the one shown in the following figure:

Figure 9.9 – Polygons of the infiltration areas of the watershed.
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8. Once finished drawing the polygon, enter the file name Infiltration1.txt as shown:

Figure 9.10 – Dialog to enter the parameters for the infiltration1 polygon.

9.6 Generate the mesh

The mesh is generated using the Generate TriMesh icon

Figure 9.11 shows the resulting mesh of about 140,000 cells.

Figure 9.11 – Final mesh.
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9.7 Exporting files to RiverFlow2D
Now that once you have generated the mesh, and the other layers are ready with the necessary
data, you should export the files in the format required by RiverFlow2D. We will use the Export
RiverFlow icon.

1. Click on the Export RiverFlow2D icon.

When running the export command, you need to select the raster layer that contains the
Digital Elevation Model (DEM), and the name of the project to be exported, only the name
must be indicated without any extension.

When the export files finalizes, a window will be appear as shown in Figure 9.12.

Figure 9.12 – Export dialog.

2. After entering the data, click on the OK button and the export process will begin. Once
finished, the RiverFlow2D program will be loaded with the RainfallInfiltration.DAT file.

9.8 Running the model
After exporting the files, the RiverFlow2D program is loaded with the project file from the RainfallInfiltration.DAT

example and shows the Control Data panel to it as illustrated in Figure 9.13
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Figure 9.13 – Control data panel.

As shown above, the Rainfall Components Evaporation/Infiltration are selected in the data
panel.

1. Select Rainfall/Evaporation and the rainfall data contained in the rainfall1.txt file will
appear (Figure 9.14). In the Infiltration panel the data contained in the Infiltration1 and
Infiltration2 files is shown (Figure 9.15).

Figure 9.14 – Rainfall/Evaporation component data panel.
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Figure 9.15 – Infiltration component data panel.

2. Leave all other parameters at their default values.

3. To run the model, click on the Run RiverFlow2D button. A window will appear indicating that
the model began to run. The window also report the simulation time, volume conservation
error, total input and output discharge, and other parameters as the execution progresses
(Figure 9.16).

Figure 9.16 – RiverFlow2D output graphics.
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9.9 Review the output files
The outflow hydrograph can be visualized using the cross section tool as shown in Figure 9.17:

Figure 9.17 – Output hydrograph of output.

This concludes the Hydrologic simulations tutorial.
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10 — Post-processing calculations

HydroBID Flood has three output controls that make it easier for the user to analyze the results of
the runs at specific sites in the domain calculator. These output controls are: Observation points,
Cross sections and Profiles.

This tutorial illustrates how to incorporate the output controls in a model using the QGIS inter-
face. The procedure includes the following steps:

1. Open an existing HydroBID Flood project.

2. Create ObservationPoints, CrossSections and Profiles layers, and draw the output controls.

3. Generate the mesh.

4. Running the model.

5. Review output files.

The files required to follow this tutorial can be found in the following directory:

...\Documents\RiverFlow2D QGIS\ExampleProjects\outControlTutorial

10.1 Open an existing project
1. Open QGIS

2. On the Project menu click Open... and browse to the existing project: OutControlTutorial.qgs.

This project contains the layers of the domain contour, the Digital Elevation Model DEM of
the river bed in raster format, the layer with the boundary conditions where inflow is located
in the upper left and outflow in the lower left. The boundary conditions are a hydrograph
with a peak discharge of 6,500 ft3/s and outflow condition set to Free outflow. When you
open the project you will have an image of the project loaded in QGIS as shown in Figure
10.1.
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Figure 10.1 – Project screen loaded in QGIS.

10.2 Create a template of the layers

ObservationPoints, CrossSections and Profiles

and draw the output controls
To add the templates where the different output controls are drawn involves the following steps:

1. Create the templates of the layers ObservationPoints, CrossSections and Profiles: for this
in the HydroBID Flood toolbar click on the New Template Layer button

2. In the plugin window activate the checkBox ObservationPoints, CrossSections and Profiles,
as shown in the Figure below:
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Figure 10.2 – Plugin to add the new templates layer.

3. Edit the layers and draw the output controls: Select in the layers panel, the Observation-
Points, CrossSections and Profiles layers one by one.

4. Click on the Toggle Editing button:

A pencil will appear on the label of the layers, indicating that the layers are in edit mode:

5. Draw the lines or points that represent the output control: To draw the cross sections, profiles
or observation points, the Add Feature tool will be used.

for the CrossSections and Profiles layers, the icon for the Add Feature button is

in the case of a point layer like ObservationPoints, the icon is

100



Post-processing calculations

6. Drawing the cross sections: Select the CrossSection layer, and activate the Add Feature
button.

7. Proceed to draw three sections: One at the beginning of the channel, another in the middle
and the third almost at the end of the channel, identify (XSECID) as: Section1, Section2
and Section3, with intervals (ND CS) of 10, 15 and 20 respectively. The attribute tables of
the sections will be as shown in Figure 10.3 and at the end of the drawing a similar image
should appear as shown in the following Figure 10.4.

Figure 10.3 – Attribute windows for the three cross sections.
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Figure 10.4 – Transversal sections incorporated into the model.

8. Save the polygon by clicking the Save button

and click on Toggle Editing button

to deactivate Edit mode on the CrossSections layer.

9. Drawing the Profile: Select the Profile layer and activate the Add Feature button, we proceed
to draw the profile along the channel central axis, identifier (PROFILEID) is Profile1 and the
number of intervals (ND PR) equal to 50. The attribute table will be as shown in Figure 10.5.
Once finished drawing, it should appear like the one shown in the following Figure 10.6.
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Figure 10.5 – Attribute window for the profile.
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Figure 10.6 – Profile (green line) incorporated into the model.
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10. To finalize the profile drawing, save the polygon by clicking the Save button

and click on Toggle Editing button

to deactivate Edit mode on the Profile layer.

11. Drawing the observation points: Select the ObservationPoints layer, and activate the Add
Feature button, proceed to draw two observation points, the first between sections 1 and 2
and the second between sections 2 and 3. As an identifier, (Obsid) is assigned Point1 and
Point2 respectively. The attribute tables will be as shown in Figure 10.7 and at the end of
the drawing you should have an image similar to the one shown in the following Figure 10.8.

Figure 10.7 – Attribute windows for the two observation points.
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Figure 10.8 – Observation points incorporated into the model.

12. To finish the drawing of the observation points, you click again on the Toggle Editing button
to disable the editing mode of the ObservationPoints layer.

10.3 Generate the mesh
The mesh is generated with the Generate TriMesh button

The result is a mesh of approximately 9,400 cells, as shown in Figure 10.9.
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Figure 10.9 – The mesh generated.

10.3.1 Exporting files to HydroBID Flood
Now that the mesh is generated and the other layers are ready with the necessary data, export
the files in the format required by HydroBID Flood.

1. Click on the Export HydroBID Flood button

2. When run the plugin a window is displayed, select the raster layer that contains the Digital
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Elevation Model (DEM) and the name of the project to be exported.

3. Input the name without any extension. For this example it will be: OutControl.

4. Before executing the plugin, activate the layer with the DEM (if it is deactivated).

Once the plugin is executed, a window will be shown (Figure 10.10), as it should be for our
example.

Figure 10.10 – Plugin to export the files to HydroBID Flood.

5. Once finished inputting the information, click on the OK button and the export process will
begin.

Once it is finished, HydroBID Flood will be loaded with the OutControl.DAT file.

10.4 Running the Model
After exporting the files, HydroBID Flood opens with the project file of the OutControl.DAT sample
and shows the Control Data panel to it as illustrated in Figure 10.11.
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Figure 10.11 – Control data panel.

You can observe in the control panel in Output Options the outputs of results for cross sections,
profiles and observation points are selected.
Leave all other parameters at their default values.

To run the model, click on the Run RiverFlow2D button. The window that HydroBID Flood
presents while running the model shows: simulation time information, volume conservation error,
total discharge of inflow in and outflow, as well as other parameters as execution progresses
(Figure 10.12).
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Figure 10.12 – River Flow2D output graphics.

10.5 Review output files
HydroBID Flood generates the files with the extensions .xseci (metric units) and .xsece (English
units) which report the results along the cross sections. it generates files with extensions .prfi

(metric units) and .prfe (english units) which report the results along the profiles and generates
the files with the extensions .outi (metric units) and .oute (English units) that report the results
in the observation points.

Figure 10.13 shows an extract of the OutControl.xsece file with results at the cross sections:
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Figure 10.13 – OutControl.XSECE file.

Figure 10.14 shows an extract of the OutControl.prfe file with the report of the profile results:
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Figure 10.14 – OutControl.PRFE file.

Figure 10.15 shows an extract of the RESvsT 0004938.oute file with the report of the results
of the observation point. Point1:
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Figure 10.15 – RESvsT 0004938.oute file.



11 — Advanced digitization/Snapping

In many cases the drawing of polygons that share borders (contiguous) is required. Trying to do
this manually usually produces polygon overlap errors, or it may generate gaps as illustrated in
the following figure:

Figure 11.1 – Areas with overlap and empty spaces in manual digitization of adjacent polygons.

This tutorial illustrates how to use the QGIS Snapping tool to facilitate the scanning of adjacent
polygons. The procedure includes the following steps:

1. Open an existing HydroBID Flood project.

2. Activate the Snapping tool.

3. Configure the Snapping tool
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4. Draw contiguous or adjacent polygons using the Snapping tool.

The files required to follow this tutorial can be found in the following directory:

...\Documents\RiverFlow2D QGIS\ExampleProjects\SnappingTutorial

11.1 Open an existing project

1. Open QGIS

2. In the main menu go to Project →Open... browse to the existing project: SnappingTutorial.qgs.

This project contains the basic templates of a HydroBID Flood project and a raster with 4
areas with different Mannings n coefficients derived from land cover and land use maps. From
this raster, the polygons of the Manning N layer will be drawn. When the project is opened, a
project image will be loaded in QGIS as shown in Figure 11.2.

Figure 11.2 – Project screen loaded in QGIS.

115



Advanced digitization/Snapping

11.2 Activate the Snapping tool
To have the Snapping tool, you must activate it beforehand:

1. Open the configuration options window: In main menu→ Settings→ Options...

2. In the Settings window, click on the Digitizing tab.

3. In Snapping, activate the option Open snapping options in dock window (Figure 11.3). As
indicated by the label

4. After accepting the changes, exit and restart QGIS.

Figure 11.3 – QGIS Options / Digitizing Window.

Once you restart QGIS and open the project again you should have an image similar to the
one shown in Figure 11.4 where you can see the Snapping tool panel at the bottom. If it does not
appear, Open the main menu→ Configuration→ Snapping options..., to load panel.
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Figure 11.4 – QGIS with snapping panel.

11.3 Configure the snapping tool
Before starting to draw the Manning’s n polygons, the snapping tool should be configured as
follows:

1. In Layer selection, chose Advanced

2. In the list of layers, you unselect all but the layer where the polygons will be drawn. In this
case the Manning N layer is selected.

3. Select the box to avoid intersections in the Manning N layer.

The configuration window of the Snapping tool should be as shown in the following Figure:

Figure 11.5 – Snapping configuration panel.
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11.4 Draw contiguous or adjacent polygons using the

Snapping tool
To draw the polygons with the information of the Manning’s n coefficients we proceed as follows:

1. Edit the Manning N layer: In the layers panel, select the Manning N layer

2. In the digitalization toolbar click on the Toggle Editing button

A pencil icon will appear in the Manning N layer indicating that the layer is in edit mode:

3. Draw the polygon that demarcates the Manning’s n area: Using the Add Toggle Editing
button in the digitalization toolbar

proceed to draw the polygons. Start by drawing the polygon in the bottom of the watershed
shown in gray which corresponds to n = 0.02. After completing the drawing you should have
an image similar to the one shown in the following figure:
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Figure 11.6 – The first polygon sketch.

4. Proceed to draw the second polygon. This will be the small yellow polygon to which cor-
responds to n = 0.30. To draw the polygon, follow the boundary with the green polygon
as indicated by the raster, but in the boundary with the polygon already drawn (the gray)
an overlap will be made so that the snapping tool takes the edge that already exists and
completes the polygon. Try to make a path as shown in the figure below:

Figure 11.7 – Drawn of the second polygon.

5. Right-click to finish the drawing.
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6. Enter the Manning coefficient, n = 0.30 and you will have an image like the one shown below
where you can see how the final drawing of the second polygon took the vertices of the first
adjacent polygon:

Figure 11.8 – Final draw of the second polygon.

7. The third polygon to be drawn will be the large yellow polygon. Just as in the previous case,
the contour of the polygon according to the raster is faithfully followed, but in the adjacent
polygons it is already drawn overlapped. The figure below shows the initial drawing, with an
approach in the area where the overlap is made with the existing polygon:

Figure 11.9 – Preliminary draw of the third polygon.

8. After finishing the drawing and assigning the Manning N umber to the polygon, the final
drawing of the third polygon will be shown as shown below:
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Figure 11.10 – Final draw of the third polygon.

9. The fourth polygon to draw will be the green polygon which corresponds to n = 0.45. To do it
will follow the outer boundary of the same and the boundary with the brown polygon. Then
a thick overlap will be made within the polygon already drawn, the yellows and the gray, as
shown in the figure below:
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Figure 11.11 – Preliminary draw of the fourth polygon.

10. After finishing the drawing and assigning the Manning’s n value to the polygon, you will have
the final layout of the third polygon as shown below:

Figure 11.12 – Final draw of the fourth polygon.
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11. To finish, draw the fifth polygon of brown color, which corresponds to n = 0.03. For this the
outer limit is drawn following the contour of the raster and for the shared limits an overlap is
made inside the neighboring polygons as shown in the figure below:

Figure 11.13 – Preliminary draw of the fifth polygon.

12. After finishing the drawing and inputting the Manning coefficient to the polygon, you will have
the final drawing of the third polygon as shown below:
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Figure 11.14 – Final draw of the fifth polygon.

13. To finish, click on the Toggle Editing button

changes are accepted and saved. Then the layer of the raster Manning Map n is deacti-
vated, and the Manning N vectorized layer can be observed as shown in the Figure below:

Figure 11.15 – Final draw of the Manning N layer.
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11.5 Delete a polygon
Suppose you want to delete the last polygon created because you are not satisfied with the result.
In that case you can proceed doing as follows:

1. The Manning N layer is edited using the Toggle Editing button

2. Then the polygon to be eliminated is selected using the Select Feature button

3. With the active select Feature tool, click on the polygon to be deleted and it will be high-
lighted in yellow to indicate that it is selected (Figure 11.16).

Figure 11.16 – Polygon to be deleted selected.

4. Then the polygon is deleted either with the Delete key on the keyboard or with the Delete
selected button
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Figure 11.17 – Manning N layer with the polygon removed.

5. Finally, the changes are saved and the editing mode of the layer is deactivated by clicking
on the Toggle Editing button.
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12 — Creating raster elevations from
X Y Z data sets

HydroBID Flood uses elevation data in raster format. For instance, to load an ASCII grid file, from
the Layer menu, click Add Layer, and then click Add Raster Layer... You may also click the Add
Raster Layer button:

In this example we will use elevation data available in a tab delimited X Y Z file, and create an
interpolated raster layer.

The X Y Z file can be formatted as comma, space or tab delimited data, where the first two
columns correspond to point X and Y coordinates and the third column is the point elevation Z as
shown in the following figure.

Figure 12.1 – File containing terrain elevation points.

First, the X Y Z file is loaded to create an event layer. This can be accomplished as follows:

1. From the Layer menu, click Add Layer, and then click Add Delimited Text Layer... Alterna-
tively, you may also click the Add Delimited Text Layer button:
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the following dialog is presented:

Figure 12.2 – Dialog to create a layer from delimited data text file.

2. Here you must indicate the location and name of the file with the X Y Z data.

3. Make sure that the first row has the names of the fields, and this is assigned to X field,
field 1 and Y field, field 2, then click OK to load the points in the project window. The
Coordinate Reference System Selector dialog box appears again and we can click OK to
continue making sure that the CRS is the appropriate one.

4. As surely the points are not within the extension of the window, you will have to click with
the right mouse button on the label of the created layer and select the option Zoom to the
layer.
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Figure 12.3 – How to zoom a layer.

5. The points should appear in the project window:

Figure 12.4 – Layer of points created from delimited data file.

6. The raster is created interpolating from the data in the point layer. For that we will use
the Interpolation command which is found on the Raster menu under Interpolation. This
command is a plugin that is installed by default in QGIS. If for any reason it does not appear,
on the Plugins menu, click Manage and Install Plugins..., type Interpolation on the search
field, and then then select the Interpolation Plugin checkbox to enable it.
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Figure 12.5 – Loading to the QGIS interpolation plugin.

When executing it, the following dialog window appears:

Figure 12.6 – Interpolation plugin window.

7. In this window select the layer to be interpolated to create the raster, in this example we
assume it is a point layer that we just created named HohRiverBedElevations. Change it
by selecting the dropdown for Vector Layers. We select the field that has the attribute that
was used as the value to interpolate, in this case the z field. This is done by clicking the
dropdown for Interpolation Attribute, selecting Z, then clicking the Add button.

8. Once added, go to select the interpolation method. There are 2 options: triangular interpo-
lation (TIN), or Inverse Distance Weighting (IDW). In this case the TIN method is selected,
then the resolution of the raster is defined, which is fixed to cells of 10ft × 10ft, which
generates a raster of 315 columns x 514 rows.

9. Select the path to the folder where the raster layer is to be created. It is recommended to
point to the project folder directory chosen earlier in the tutorial.
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10. Click OK.

Once the process is completed, the raster resulting from the interpolation will be displayed on
the screen, by default it is rendered in gray gradient as shown in Figure 12.6.

Figure 12.7 – Digital elevation model in raster format created by interpolation.

Note: Right-clicking on the label of the created layer and selecting Properties allows you to change
the rendering style for a more informative color palette.
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Figure 12.8 – Window to change the render style of a raster layer.

And now the raster layer is displayed with the new color palette selected:
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Figure 12.9 – Digital elevation model with color render.

It is convenient to move the raster layer created to the end of the list of layers, thus it does not
interfere with the display of other layers.
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